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Certification Prep Series
by D. Michael Ploor
Certification Prep Series consists of individual guides that provide practice in the 
basic skills needed to be successful using the corresponding software. No previous 
software experience is required. Although the guides focus on learning skills, not 
test taking, users that complete the practice will be prepared to take the official 
software certification exam and exhibit workplace readiness. Step-by-step instructions 
demonstrate actual software commands and features, building from basic to advanced. 
Content is divided into small units for better learning and usage. There is no need to 
purchase additional materials as all lesson content is created using the software.

•	 Provides an affordable way to prepare for industry certification versus other methods.
•	 Integrates easily into existing classroom activities.
•	 Focuses on hands-on experience to develop skills.

Microsoft Office Products
•	 Microsoft Word 2016

•	 Microsoft Excel 2016

•	 Microsoft PowerPoint 2016

•	 Microsoft Outlook 2016

•	 Microsoft Access 2016

•	 Microsoft Word 2013

•	 Microsoft Excel 2013

•	 Microsoft PowerPoint 2013

•	 Microsoft Outlook 2013

•	 Microsoft Access 2013

Adobe Products
•	 Adobe Photoshop Creative Cloud

•	 Adobe Dreamweaver Creative Cloud

•	 Adobe Flash Creative Cloud

•	 Adobe Illustrator Creative Cloud

•	 Adobe InDesign Creative Cloud

•	 Adobe Photoshop CS6

•	 Adobe Dreamweaver CS6

•	 Adobe Flash CS6

•	 Adobe Illustrator CS6

•	 Adobe Photoshop CS5

•	 Adobe Dreamweaver CS5

•	 Adobe Flash CS5
Microsoft Office 2010 is also available.

Start on Monday.
Test on Friday.
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Introduction
The Common Occupational Readiness Essentials (CORE) series of certifi cation 
preparation guides focuses on mastering the essential basic skills needed as 
a workplace-ready user of the software. The goal of each CORE certifi cation 
preparation guide is to provide practice in each essential basic skill required by 
employers who use the software. To prove workplace readiness, you will also be 
prepared to take the offi cial certifi cation exam for the software.

CORE Adobe Dreamweaver Creative Cloud will help prepare you to take the Adobe 
Certifi ed Associate (ACA) Adobe Dreamweaver Creative Cloud certifi cation 
exam. It provides step-by-step instruction for the features and commands covered 
on the certifi cation exam. The focus of the lessons is to practice using the actual 
commands and features instead of creating a complete end product. Most lesson 
content is created using the software, and minimal downloading of fi les is required. 
Furthermore, each certifi cation preparation guide is broken down into small learning 
units to enable better comprehension and application of the software. Where required, 
answers are provided at the back of the certifi cation preparation guide.

Certifi cation as an Adobe Certifi ed Associate demonstrates an aptitude with Adobe 
software. ACA certifi cation is offered for Adobe Dreamweaver, Adobe Flash, Adobe 
Photoshop, Adobe Premier, Adobe Illustrator, and Adobe InDesign. Certifi cation 
exams are provided by Certiport, Inc., through various testing facilities. Visit
www.certiport.com for more information on registering for certifi cation exams.

About the Author
D. Michael Ploor is the author of the CORE series of certifi cation preparation guides. 
Mr. Ploor’s students have achieved exceptional results with the CORE certifi cation 
preparation guides. His students collectively pass more than 500 industry certifi cation 
exams each year without the need for other preparation materials. Mr. Ploor has 
demonstrated the strength of integrating the CORE guides in a diverse mix of courses.

Mr. Ploor is also the author of three textbooks on the subject of video game 
design: Introduction to Video Game Design, Video Game Design Foundations, and 
Video Game Design Composition. He is a National Board Certifi ed Teacher in Career 
and Technical Education and holds an MBA degree from the University of South 
Florida. He maintains professional teaching credentials in Business Education and 
Education Media Specialist.

Mr. Ploor is at the forefront of innovative teaching and curriculum. He developed 
STEM curriculum while serving as the lead teacher in the Career Academy of 
Computer Game Design at Middleton Magnet STEM High School. Mr. Ploor 
has applied his skills as a STEM Curriculum Integration Specialist in designing 
innovative curriculum and by collaborating to construct the state standards for 
video game design in several states. He has also been instrumental in authoring 
competitive events for Career and Technical Student Organizations such as the 
Future Business Leaders of America (FBLA) and Phi Beta Lambda (PBL).

In addition to publishing textbooks and lessons, Mr. Ploor provides professional 
development as a frequent presenter at regional and national conferences to 
promote CTE education and video game design curriculum for the high school and 
middle school levels.
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Lesson 5
Designing a Website

Objectives
Students will explain the preproduction process of website design. Students will 
describe the use of cascading style sheets. Students will identify elements of the 
Dreamweaver workspace. Students will save a local website. Students will apply 
inline style formatting. Students will create an internal style sheet. Students will 
edit an existing CSS rule. Students will apply page formatting to a web page. 
Students will explain WYSIWYG editing. Students will create an external style 
sheet. Students will inspect the application of an external CSS. Students will 
customize a workspace.

Designing a Website
A web designer should not simply start building a website and then later ask the 
client how he or she likes it. This would result in not only the work needed to create 
the website, but the work caused by all of the changes the client is sure to make. It 
is better to do the job right the fi rst time and have few modifi cations later. For this 
reason, a web designer should engage in preproduction activities before designing, 
building, and programming a working website.

Preproduction
The preproduction stage involves gathering information and designing the 
layout of the website. The web designer will interview the client, conduct 
research on competing websites, and gather customer demographic information 

to best determine what requirements need to 
be met by the website. Being able to effectively 
evaluate a website will prove a valuable skill in 
preproduction.

Client Interviews

When working with a client, it is important to have 
a full understanding of what he or she expects. You 
should conduct preproduction interviews with the 
client to brainstorm ideas and fully communicate 
the goals for the fi nished product, as shown in 
Figure 5-1. A preproduction interview takes place 
before any production work begins. If you start 
working without this important step, the client may 
be dissatisfi ed with the result and you would have 
to redo the project. In the professional world, you 

Monkey Business Images/Shutterstock.com

Figure 5-1.

Preproduction interviews are critical to understanding 
the client’s needs and wants.
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are paid by the client, and the client will not pay for unsatisfactory work that does 
not meet the specifi ed goals.

Working with the client in a preproduction interview, you will need to identify 
not only the target market, but also the client goals. Ask questions to identify 
the business type, business goals, website purpose, target audience, who are 
competitors locally and nationally, what platforms will display the site, and what 
the designer should focus attention on when planning the site. Research the client 
company before the interview so you can construct appropriate interview questions.

The client goals set the direction of the creative work. The client is paying you to 
create something to meet a goal, often attracting customers. The client may have a 
goal of informing or attracting attention. The use of color is important in attracting 
attention, while color in informational websites may have little value.

Client Needs vs. Client Wants

Many times, a client places wants ahead of needs. A client might want fl ashy 
graphics, sound, video, and games on the website without considering how or if 
these features assist the goal of the website. It is the designer’s job to focus fi rst on 
the needs of the client and then build in some of what the client wants if appropriate 
to the goal of the website.

A need is determined by what the website is intended to do. If the site is for selling 
fl owers, then it needs to show fl ower arrangements and have a clear ordering 
process. If the client wants to have an encyclopedia section about the history 
of roses, you may need to refocus the discussion on the goal of the website to 
determine what is needed. Getting the client to understand and stick to the goal 
may take some convincing. In this case, refocus the client on the purpose of the site, 
which is to make it easy for customers to choose and purchase fl owers. Remind 
the client that after the site is fully functional and meets the goals, then additional 
pages can be added. If the website fails to meet the intended goals, the client will be 
upset even if the site has the design elements he or she wants.

Relevant Content

After an effective client interview, the designer must work with the client to gather 
relevant content. Each image, color, passage of text, and other design elements 
need to be compared to the expectations of the target audience. If the content is not 
relevant for the audience, then it must be changed.

To ensure that the content meets the needs of the target audience, members of that 
audience should be surveyed. A survey is a series of questions posed to a specifi c 
group of people. People from the target audience should view the content and 
provide feedback as to what they like, do not like, and fi nd relevant or appropriate.

Relevant content for a target audience of children can also cause some issues. The 
content must be age appropriate for the children users and also appropriate to the 
parent. Many websites use a kid-safe registration, where a parent gives consent 
for his or her child to use the site or a portion of the site. A kid-safe registration is 
a login that requires a parent’s permission to activate, usually through an e-mail 
confi rmation.
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Client Deliverables
Before leaving the client and beginning to plan the website, the designer must have 
a fi rm understanding of what work will be performed, a timeline or due date for 
delivering the website, and how design changes will be reported. A statement of 
work is a contract that outlines the scope of work the designer is to perform. The 
statement of work should include what type of work the client is hiring you to 
do, the scope of work that the designer is to perform, all mandatory deliverables, all 
mandatory deadlines, and how many changes are included without additional charges.

The type of work performed may be design only or it may include hosting. You 
may include other services in the type of work performed, such as logo design or 
image editing. This work is not usually performed by the web designer, but can be 
included if your skill set allows and if negotiated with the client. Describing the 
type of work is a very important part of the statement of work. The description 
should be very detailed to make sure the designer and client both know what work 
is being done and what other work may be required from someone else.

The scope of work states the amount of content that will be provided. For example, the 
scope may limit the project to a six-page website with one form to collect customer data. 
If the client later decides to add e-commerce for selling of goods, that would be outside 
of the stated scope of work. This would need to be covered under a new contract.

A timeline for deliverables outlines dates when the client is required to provide 
web resources and when the designer must provide draft and fi nished work. 
Deadlines must be specifi ed for all client deliverables, such as images, videos, 
pictures, logos, and textual content. The designer’s work is based on the client 
providing materials on time. If the client is late, the designer cannot complete his or 
her work. Additionally, deadlines must be specifi ed for when the designer delivers 
a draft website, the window of time for review and changes, deadline for a change 
request, and a fi nal deadline for the launch of the website.

Changes are typically permitted when the draft website is reviewed by the client. 
However, this must be specifi ed in the statement of work. A limited number of 
changes should be specifi ed in the statement of work. Without a limit, the client will 
be able to continually request changes. This could lead to a never-ending project. 
Whenever asking for a change, the client should submit a change request document. 
This document records the specifi cs of the alteration so the designer knows what to 
modify. It should be kept as part of the formal documentation for the project.

Storyboards
As part of the creative process, a standardized layout should be created to provide 
consistency throughout the entire website. The web designer creates a wireframe 
for the layout. A wireframe is essentially the website layout created using boxes to 
show the placement of elements on a web page, as shown in Figure 5-2. To make the 
website easy to use, most of the elements should be the same on each page of the site. 
Drastic changes in layout and color from one page to the next make the user feel like 
he or she accidentally navigated to a different site. Having a unity of design allows the 
user to quickly learn the basic site navigation and apply it on each page of the site.

Using the wireframe layout, a designer creates a storyboard for the entire website. 
A storyboard is a collection of enhanced wireframe sketches to show basic layout 
and content for each web page. Each web page is displayed as a wireframe panel 
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in the storyboard. Each wireframe panel shows 
the important features of the web page, element 
layout, color palette, font samples, and navigation 
description. In addition to the design elements, each 
panel should list the web page title, fi le names, and 
navigational links and display images or sketches 
of intended graphics or rich media content.

Rich media, such as animations, movies, interactive 
content, or games, need to be clearly marked in the 
fl owchart and explained as to how it will impact 
the user and the technology. A fl owchart is a 
chart listing features to include on a web page. 
Technology lag must be addressed for rich media 
and interactive content. Interactive content provides 
the user the opportunity to interact, control, or 
modify what is available on the web page. Games, 
posts, message boards, and more are all part of 
interactive content. Showing the controls on the 
storyboard of how the user will access the rich 
media content will address key issues when trying 
to up-sell the client to include rich media.

Additionally, the designer should list the format 
and plug-ins needed for the rich media. A plug-
in is a program installed on the user’s computer 
to allow rich media content to play. If the rich 
media requires a plug-in, a link to the installation 
should be provided. Otherwise, the user may not 
be able to use or view the content. Common tools 
for rich media and plug-ins needed are shown in 
Figure 5-3.

Development Preapproval
With a good storyboard in place, the client can see the placement of the design 
elements, give feedback, and approve the design before the website production 
begins. Mark the storyboards with the changes requested by the client. Have the 
client initial each panel to approve the basic design features for each page. This 
practice will prevent misunderstandings and create a written record for all changes 
requested by the client. Once the client approves the storyboard, production of the 
website can begin.

Cascading Style Sheets
Because a website should maintain a consistent look and feel from the home page 
to every other page, the World Wide Web Consortium has recommended the use 
of cascading style sheets in website design. A cascading style sheet (CSS) holds 
the formatting defi nitions or option settings for all web pages that reference it. The 
storyboard can be used to construct the CSS so each page has a similar look and the 
website maintains unity. The main formatting defi nitions such as font family, font 
size, font color, background color, and more are contained in a style sheet.

Standardized
content layout

Logo and Address

Page Image

Page Text

Home

Products

Services

Ordering

Contact Us

Download

Goodheart-Willcox Publisher
Standardized

navigation menu

Figure 5-2.

This is a typical example of a wireframe used in the 
design process of a website.

Content Tool Plug-in

Adobe Flash Flash Player

JavaScript JavaScript installed

HTML5 None

Goodheart-Willcox Publisher

Figure 5-3.

Common tools for providing rich media on a web 
page and the associated plug-in required.

Dreamweaver CC.indd   47Dreamweaver CC.indd   47 2/22/2017   9:37:47 AM2/22/2017   9:37:47 AM



48 CORE Adobe Dreamweaver Creative Cloud

For individual use only—reproduction or duplication of this copyrighted material is prohibited.  Copyright Goodheart-Willcox Co., Inc.

The main idea behind CSS design begins with an understanding of the term 
cascading. Cascading refers to a series of steps, such as a series of steps in a waterfall. 
This is applied to web design by establishing a hierarchy for formatting a website. 
A formatting defi nition of a parent (higher up in the hierarchy) will be applied to 
a child (lower down in the hierarchy) unless the child contains specifi c formatting 
defi nitions to override it.

Types of Style Sheets
An external style sheet is a style sheet in a separate fi le. This is the most effective way 
of separating the contents from the design of a website. Each web page links to the 
external style sheet to defi ne the overall style settings. A designer might set up a main 
external style sheet and have all the pages of a website include the formatting defi ned 
in that style sheet. All of the web pages would look exactly the same in terms of 
format, but the designer adds different images and text to customize each web page.

If the designer wants to override the external style sheet, this is typically done using 
an internal style sheet. An internal style sheet is a set of formatting defi nitions 
within the code for a given web page. Any overrides to the external style sheet are 
placed in the <head> section of the web page defi nition. These changes only affect 
that specifi c page and do not alter the external style sheet.

Sometimes the designer only wants to change the formatting of a single line of 
the web page. An inline style is placed within the <body> section of the web page 
defi nition to change the formatting defi nitions of a single line or small area of the 
page. Inline style sheets override all other style sheet defi nitions.

Essentially, the cascade hierarchy has the browser apply the external style sheet to 
the web page unless an internal style sheet exists. If there is an internal style sheet, 
it will be applied as the next step in the cascade unless there is an inline style sheet. 
An inline style sheet will be applied as the next step in the cascade unless there are 
any other inline style sheets.

CSS Templates
Through the use of cascading style sheets a designer can create a design template 
for the website. A template is a preformatted page or section that simply needs the 
content added. A letter template is preformatted with all components and style of 
a business letter. The letter only needs the specifi c content, such as the body of the 
letter, added to create a new custom letter that is properly formatted. A CSS allows 
the same thing to happen with web page design.

An external CSS can be specifi ed to create a template for the different types of pages 
used within the website. For example, a CSS fi le might be named Forms.css. This 
could be the template for all pages that contain forms for customers to complete. 
That keeps all the forms looking similar.

A single web page can link to several external CSS fi les. An element such as the 
navigation panel that contains buttons to link to the home page, contact page, or 
other main pages can be created once and used over and over again on each web 
page. The designer would create a single CSS fi le to defi ne these navigational 
elements, and then link it on each page where it is needed. This CSS fi le can also be 
a reusable template for this specifi c element.
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How to Begin
 1. Within your working folder, create a subfolder named Website. This will serve as 

a local folder in which to store the website and all associated fi les. A local folder 
exists on your computer, not on a network or web server.

 2. Inside the Website folder, create a subfolder named CSS. A subfolder is also 
commonly called a nested folder. The CSS folder will hold all of the CSS 
documents for the website.

 3. Create a second subfolder or nested folder named Media. This folder will hold all 
images and other media for the website.

 4. Launch Dreamweaver. When Dreamweaver opens, a splash page is displayed to 
help you quickly start a new project or continue working on an existing project.

 5. Click Quick Start on the left of the splash screen, and click the HTML Document 
tile on the right side. A new HTML project is opened.

 6. Review the parts of the Dreamweaver interface as shown in Figure 5-4.

Menu bar Workspace switcher

Panels

Document
toolbar

Live window

Code window

Common

toolbar

Document tab

Status bar
Figure 5-4.

The basic layout of the Dreamweaver interface.
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Workspace
A workspace is the layout of the toolbars, panels, and document on the screen. 
Changing the layout by moving panels, adding more tools, rearranging panels, 
or otherwise changing the screen setup changes the workspace. A workspace can 
be customized to display the toolbars and panels in different locations to help 
the designer perform best. You may also create custom views by dragging the 
workspace tools to different locations and saving the workspace.

The Menu bar holds commands in a pull-down menu format. Click a pull-down 
menu to see the commands it contains, and then click a command to activate it. The 
Menu bar is available in the PC version of Dreamweaver.

Dreamweaver makes use of panels. A panel is a small window that holds 
commands or options. A panel may also have multiple tabs to group commands by 
function. A designer can arrange the panels in any confi guration. The panels can 
even be moved from one panel group to another. Panels may be expanded with the 
commands visible or collapsed. Collapsed panels have been minimized to icons to 
save space on the screen. Clicking a panel icon will expand the panel.

The document window is the area where the web page is created. The view in the 
document window can be of code, the live view of the web page, or other view. The 
ability to switch between a view of the web page and the code that defi nes the page 
greatly helps the designer.

Above the document window is the Document toolbar. The document tab contains 
the document. The designer can have multiple documents open in Dreamweaver at 
the same time. Each document will have a separate document tab. The designer can 
navigate between open documents by simply clicking the different document tabs.

 7. Click the workspace switcher button in the top-right corner of the screen. This 
will be, by default, labeled either Standard or Developer, depending on what was 
specifi ed when Dreamweaver was set up. The Developer workspace is intended 
to focus on coding, while the Standard workspace includes visual tools and a 
split screen of the live view and the code view. The current workspace will be 
checked in the drop-down menu displayed by clicking the workspace switcher 
button.

 8. Click either Standard or Developer in the drop-down menu that is displayed, 
whichever is currently not checked. Notice how the arrangement of toolbars and 
panels has changed.

 9. Applying what you have learned, set the Standard workspace current. The 
Standard workspace is often used by those new to Dreamweaver because 
many tools are displayed. This is the workspace shown in Figure 5-4. Unless 
instructed to change workspaces, use the Standard workspace for the lessons in 
this guide.

 10. Click the tab on the Insert panel to display the panel. The Insert panel contains 
many of the most commonly used tools for design elements. Each area on the 
Insert panel contains a set of tools grouped by design element.

 11. Click the Code link on the Document toolbar. The document window switches 
to display only the code window, as shown in Figure 5-5. Also notice the 
buttons in the Common toolbar have changed. The available tools help edit the 
code.
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 12. Locate line 3, which contains the code <head>. 
As explained earlier, this is an opening tag. 
In this case, the tag begins the head section of 
the code. Recall that information in the head 
section will not be visible on the web page. This 
section has information such as the web page 
title, meta tags, links to any external CSSs, and 
any internal CSSs.

 13. Locate the code on line 5. This line contains 
the code <title>Untitled Document</title>. The 
current name of the web page, which is not 
the name of the fi le, is Untitled Document. Click 
in front of the U, delete Untitled Document, and 
add the text All About Me. The name, or title, of 
the web page is now All About Me. This is what 
will appear in the title bar of the web browser. 
Placing information between an opening and 
closing tag will make that information appear 
as content.

 14. Locate line 6, which contains the code </head>. As explained earlier, this is a 
closing tag for the head section.

 15. Click on line 8, and position the insertion point after the <body> tag.

 16. Press the [Enter] key to start a new line.

 17. On the new line 9, add the text Welcome to My Website. This text will appear on 
the web page as content.

 18. Click the arrow next to the Live link on the Document toolbar, and click 
Design in the drop-down menu. The design view displays the web page in the 
document window as it will appear in a web browser. Notice that the text added 
to the body section of the code appears on the web page.

Local Site Saving
For this project, a local site is being created. All work will be saved on your 
computer. Later, all of the completed fi les for the website can be uploaded to a web 
server and made available on the Internet.

 19. Click File>Save As… in the pull-down menu. A standard save-type dialog box is 
displayed.

 20. Navigate to your working folder, and the Website subfolder.

 21. Click in the File name: text box, and enter index. The fi rst page or home page of a 
website is almost always named index.html or index.htm.

 22. Click the Save button to save the web page. If a message appears asking to 
update links, click the Yes button.

Inline Style Formatting
While the W3C standard for website formatting is a CSS, at fi rst you will use inline 
styles so you can directly see how each style element affects the web page. Later, 
you will create external style sheets to maintain consistency between web pages 
and speed up development.

TIP
Dreamweaver 
automatically uses 
the .html extension, 
but this can be 
overridden by 
manually entering 
the .htm extension.

CodeLine numbers

Title

Figure 5-5.

In the code view, the code composing the web page is 
displayed.
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 23. Click the Windows pull-down menu, and then click Properties in the menu. The 
Properties panel is displayed, most likely as a fl oating (not docked) panel. If the 
panel is already displayed, clicking the menu entry hides it.

 24. Make sure the design view is displayed in the document window and the 
Properties panel is displayed.

 25. Select the text Welcome to My Website by clicking in front of the text, holding 
down the left mouse button, and scrolling to the end of the text.

 26. In the Properties panel, click the HTML button. The Properties panel is used to 
inspect and change the individual properties of a selected item, or to change the 
properties of the entire page. When the HTML button is clicked, the properties 
are for HTML, not for a CSS.

 27. Click the Format drop-down arrow, and click Heading 6 in the drop-down list to 
change the property. Notice the text is changed to a very small size.

 28. Click the Split link on the Document toolbar. The view in the document window 
displays both the code view and design view at the same time. Notice that line 
9 contains the tag <h6>, as shown in Figure 5-6. This tag applies the Heading 6 

TIP
The name of the 
web page appears 
in the Document 
Title text box on the 
Properties panel. 
This text box can 
be used to edit the 
name.

HTML

Selected text

Property assigned

Figure 5-6.

A split view offers two different views of the web page. Here, the code view and the design view are displayed.
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style to the text between the opening and closing tags for the head. Heading 6 is 
the smallest text size.

 29. Applying what you have learned, assign the Heading 1 style to the selected text. 
Notice the changes to the tags in line 9. Any changes in design view are updated 
in code view. Heading 1 is the largest text size.

 30. On the Properties panel, click the Bold button to bold the selected text. Notice 
the <strong> tag is added to line 9. Any text between the opening and closing 
tags will be bold. This is considered an inline style because it is within a tag, the 
<h1> (Heading 1) tag.

 31. On the Properties panel, click the Italic button to italicize the selected text. 
Notice the <em> tag is added to line 9 to emphasize the text. Also notice the 
<strong> tag remains, so the text is both bold and italic.

 32. In the code window, select only the text Welcome to My Website, not any of the 
surrounding code. Then, look at the status bar. The tags applied to the selected 
text appear on the left-hand side of the status bar, in this case <body>, <h1>, <em>, 
and <strong>, as shown in Figure 5-7.

 33. Save the project by clicking File>Save on the Menu bar.

Internal Style Sheet Formatting
You may have noticed that the formatting options for inline styles are very limited. 
There is no code to center the text, change text color, or many other text formatting 
options common to word processors. Codes for these options were once part 
of HTML, but have now been deprecated or made obsolete. HTML5 is the new 
standard for web page creation, and it calls for these formatting options to be 
contained in a cascading style sheet, either internally or externally.

 34. With the text Welcome to My Website selected, click the CSS Designer panel to make 
it current. This panel is docked with the Files, CC Libraries, and Insert panels.

 35. Click the Add a new CSS source button in the Sources area of the CSS Designer 
panel. Then, click Define in Page in the menu that is displayed as shown in 
Figure 5-8. This specifi es an internal cascading style sheet. Notice lines 6 and 7 
in the code now contain opening and closing tags for a CSS.

TIP
The actual 
formatting of styles 
such as Heading 1, 
strong, and 
emphasis can be 
controlled by a CSS.

Bold

Italic

Select only the text

Tags applied

Figure 5-7.

The status bar indicates which tags are applied to the selected text.
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 36. In the Selectors area of the CSS Designer panel, 
click the plus sign (+). If you hover the cursor 
over the plus sign, the help text is Add Selector. 
Dreamweaver automatically suggests a style 
name based on the formatting applied to the 
selected text, as shown in Figure 5-9. This 
should be h1 em strong since the text is tagged 
as a Heading 1 and the emphasis and strong 
formatting have been applied.

 37. Edit the entry in the text box so it reads h1, and 
then press the [Enter] key. Notice lines 7 and 8 in 
the code now contain a section for Heading 1. 
The formatting for the <h1> tag will be placed 
within this section. This section should also be 
selected (highlighted) in the code window.

 38. Click the plus sign in the Properties area of the 
CSS Designer panel. An empty text box appears 
in which a property can be specifi ed.

 39. Enter te. Dreamweaver automatically suggests properties based on these letters. 
Select the text-align property in the list either by using the arrow keys and 
pressing the [Tab] key or clicking it with the mouse. A second text box appears, 
as shown in Figure 5-10. This is for the property’s value.

 40. Select center in the list of available values. Notice that the text in the design 
window is now centered. Also, the code for the property is automatically 
added in the code window. On line 7, the code begins the defi nition for h1. The 
defi nition must be contained inside curly brackets ({ }), the fi rst of which is at 
the end of line 7. The closing curly bracket is on line 9. On line 8, the formatting 

TIP
Notice how 
Dreamweaver uses 
indentation to help 
group the code. It 
is good practice 
to visually group 
sections of code 
using line breaks 
and tabs.

Click to display
the menu

Click to create
an internal
style sheet

Click to add
a selector

Suggested
name for style

Figure 5-9.

Adding a selector to the internal CSS.

Selected property

Select a value

Figure 5-10.

A property has been added to the h1 style in the inter-
nal CSS, and now a value must be set.

Figure 5-8.

Creating an internal CSS.
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property is applied. Currently, only the text-align: center property is added. 
Notice a semicolon (;) ends the property.

Editing CSS Rules
As you have seen, the CSS Designer panel is used to add a CSS. This panel can also 
be used to edit the CSS.

 41. Click the CSS button in the Properties panel, and then click anywhere in the 
text Welcome to My Website; do not select any of the text. Notice the Targeted 

Rule drop-down arrow in the Properties panel displays h1 to indicate the rule 
applied to the text. Any changes made to the CSS properties in the Properties 
panel will be applied to the h1 style (rule).

 42. Click the Edit Rule button in the Properties panel. The CSS Rule Definition 
dialog box is displayed for the current rule (h1), as shown in Figure 5-11.

 43. Click Type in the Category list on the left-hand side of the dialog box. The 
options for typeface are shown on the right-hand side of the dialog box.

 44. Click the Font-family: drop-down arrow, and click Segoe UI, DejaVu Sans, 

Trebuchet MS, Verdana, sans-serif in the drop-down list. Always choose a font 
from the options shown in Dreamweaver. Specialized fonts will not display 
unless the user has that font installed on his or her device. The Segoe UI, DejaVu 

Sans, Trebuchet MS, Verdana, sans-serif selection means the browser will 
display the text in either the Segoe UI, DejaVu Sans, Trebuchet MS, or Verdana 
typeface if the user has one of those fonts installed. Otherwise, the browser 
displays the text in the default sans serif font for the user’s device.

CSS

TIP
Sans serif typeface 
is traditionally 
used for headlines. 
Serif typeface is 
traditionally used 
for large blocks of 
text, such as body 
copy.

Click to select
the typeface

options

Check to
underline

the text
Color

Click to select
a color

Select the
typeface

Select
the size

Select the unit
of measure

Figure 5-11.

Defi ning the specifi c settings for a CSS rule.

Dreamweaver CC.indd   55Dreamweaver CC.indd   55 2/22/2017   9:37:48 AM2/22/2017   9:37:48 AM



56 CORE Adobe Dreamweaver Creative Cloud

For individual use only—reproduction or duplication of this copyrighted material is prohibited.  Copyright Goodheart-Willcox Co., Inc.

 45. Click the Font-size: drop-down arrow, and click 18 in the drop-down list. Click 
the drop-down arrow to the right of this setting, and click pt in the drop-down 
list. Pt stands for points. Point and pica are common units of measurement used 
in the graphic design industry. One point is 1/72 of an inch, or approximately 
0.139″. One pica is equal to 12 points, and there are six picas per inch.

 46. In the Text-decoration: area, check the underline check box. This will place a 
rule, or line, underneath the text.

 47. Click the Color: color swatch to display color options. Notice you can pick a 
color or enter a hexadecimal number in the text box at the bottom of the palette.

 48. Enter #FF0000 in the text box. This is a pure red, as refl ected in the preview. 
Click anywhere off of the color palette to set the color and close the palette.

 49. Click Block in the Category list on the left. The options in the Block category are 
used to change the paragraph settings, such as line spacing and text alignment.

 50. Make sure the Text-align: drop-down arrow displays center. This was set earlier 
when the rule was created.

 51. Click the OK button to close the CSS Rule Definition dialog box and update the 
rule. Notice how the text changes in the design view.

 52. In code view, examine the internal style sheet from line 7 to line 13. Notice the 
style sheet is updated with the code refl ecting the settings made in the CSS Rule 

Definition dialog box. A semicolon (;) is used to end each property setting.

Formatting the Page
Currently, the page has default settings, which are visually rather plain. Changing 
the page properties can allow each web page to have a different appearance. 
However, it is usually not advisable to change the appearance of each web page as 
the website will lose unity of design. Page properties are changed with an internal 
style sheet or an inline style applied to that specifi c page.

 53. In the design view, click after the word Website, and press the [Enter] key to start 
a new paragraph.

 54. In the new paragraph, add the text Welcome to my home page. Notice the text 
does not have the same formatting applied as the heading. The text formatting 
and alignment are the default setting as there is no CSS rule applied to the 
paragraph to change it.

 55. Click File>Page Properties… on the Menu bar. The Page Properties dialog box is 
displayed, as shown in Figure 5-12.

 56. Click Appearance (HTML) in the Category list. Changing the HTML code will 
not create an internal style sheet, as changing the CSS code would. Instead, an 
inline style will be created.

 57. Applying what you have learned, click the Background color: color swatch, and 
select blue (#0000FF).

 58. Applying what you have learned, change the Text: color setting to white 
(#FFFFFF).

 59. Click the Apply button to see the changes appear. Using the Apply button allows 
you to preview the appearance. If this was not what you wanted, you could 
immediately make a change and preview it again.

 60. Click the OK button to close the dialog box.

TIP
Notice the names 
of options in the 
CSS Rule Definition 
dialog box match 
the code for 
the option. For 
example, the Text-
align: drop-down 
arrow corresponds 
to the code text-align.
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 61. In the code view, notice on line 17 the code for the background color and 
text color is added within the opening <body> tag: <body bgcolor=“#0000FF” 

text=“#FFFFFF”>.

WYSIWYG Editing
WYSIWYG stands for what you see is what you get and is pronounced wi-zee-wig. 
Making changes in the design view writes the correct code in code view, so what 
you see in the design view is what you get on the web page. A WYSIWYG editor 
allows the designer to make changes to the page without manually programming 
the code.

 62. In the design view, replace the word my in the paragraph text with your fi rst and 
last name and make it possessive, such as Welcome to Mike Ploor’s home page.

 63. Click at the end of the sentence, and press the [Enter] key to start a new 
paragraph.

 64. Add the text (Insert Image Here), and press the [Enter] key. This text will act as a 
placeholder for where an image will be inserted later.

 65. Add the text Click below to visit more web pages about me, and press the [Enter] 
key.

 66. Add the text (Insert Table Here) to act as a placeholder for where a table will be 
placed.

 67. Click the arrow next to the Design link on the Document toolbar, and click Live 
in the drop-down menu. The design view is changed to display the web page as 
it would appear in a browser. Notice a slight change in appearance with more 
room at the top of the page in the live view.

 68. Locate the resolution drop-down arrow on the status bar, and click it. In the 
drop-down menu that is displayed, click 414 x 736 iPhone 6s Plus. The live view 
simulates the display of the page on this mobile device.

 69. Click 1024 x 768 iPad in the resolution menu to view the web page as it would 
be seen on an iPad.

 70. Click Full Size in the resolution menu. This is the default display size.

Click to create
an inline style

Click to change the
background color

Click to change
the text color

Figure 5-12.

Defi ning the basic appearance of the web page.
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 71. Applying what you have learned, display a split view of the code view and the 
design view.

 72. Click the Real-time Preview button on the status bar. A window appears, as 
shown in Figure 5-13.

 73. Click the one of the browsers listed in the 
window. A browser window is opened with 
the web page displayed. Notice the design view 
and the actual web page are very similar in 
appearance.

 74. Close the browser window.

External Style Sheet
Currently, all formatting is applied to the single 
page being edited. An external style sheet will 
allow the formatting to be applied to more than one 
page.

 75. In the design view, select all of the body text 
from Welcome to name’s home page. through 
(Insert Table Here).

 76. Click the plus sign in the Sources: area of the 
CSS Designer panel, and click Create a New 

CSS File in the drop-down menu. The Create a 

New CSS File dialog box is displayed, as shown 
in Figure 5-14.

 77. Click the Browse… button. The Save Style 

Sheet File As dialog box is displayed, as shown 
in Figure 5-15.

 78. Click in the File name: text box, and enter 
centering-style.

 79. Navigate to the CSS subfolder folder inside the 
LastName_Website folder.

 80. Click the Relative to: drop-down arrow, and click Document in the drop-down 
list. The URL can be relative to the document or to the root of the website. If the 
saving path is the same as the root folder, then it is relative to the root folder. 
Otherwise, the relative location is the same folder that contains the document. 
In this case, saving relative to the document will save in the LastName_Website 
folder, while saving relative to the root folder would have saved to a server 
address. The root folder is the main folder that contains all fi les or subfolders 
with fi les for the website.

 81. Click the Save button to set the fi le name and location.

 82. Click the OK button in the Create a New CSS File dialog box to create the 
external style sheet fi le.

 83. In the code view, examine line 15, which was added to the head section. External 
style sheets are referenced with a <link> tag that specifi es the URL of the CSS 
document.

Real-time 
Preview

Select a browser

Figure 5-13.

The web page can be previewed in real time in a web 
browser or on a mobile device.

Click to set the name and
location of the external CSS file

Figure 5-14.

Creating a CSS as an external fi le.
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Inspecting the External CSS
 84. Launch a fi le explorer, open the LastName_Website\CSS folder. There is one 

document stored in this folder (centering-style.css). The CSS is a separate 
document and can be linked to any web page. Any style defi nitions saved in 
this fi le will be used to control the appearance of any web page linked to this 
fi le.

 85. Switch to Dreamweaver. Notice below the tab that contains the document name 
are now two buttons: Source Code and centering-style.css. Click the centering-

style.css button. The CSS document is displayed. Notice that it is currently empty.

 86. Click the plus sign in the Selectors area of the CSS Designer panel, and enter 
body in the text box.

 87. Applying what you have learned, add the property text-align with a value of 
center. Notice how the code is added to the CSS fi le and the live preview updates 
so the body text is centered.

 88. Click File>Save in the Menu bar to save the CSS fi le.

 89.  Click the Source Code button. Notice how the code for centering the text is not 
contained within the <body> tag for the page. This is because that property is 
controlled by the external CSS.

 90. Click File>Save in the Menu bar to save the web page.

Custom Workspace
 91. Applying what you have learned, change to the Developer workspace.

 92. Locate the Snippets panel. Click and hold the Snippets panel tab, and drag 
the panel to the middle of the screen. This will fl oat the panel away from the 
docking area.

 93. Drag the Snippets panel to the Files panel tab. When a blue box appears around 
the Files tab, release the mouse button. The Snippets panel is docked with the 
Files panel.

TIP
A fi le that has 
unsaved changes 
will be indicated 
with an asterisk (*) 
next to the fi le 
name in the 
document tab.

Navigate to
the subfolder

Name the file

URL of file

Select if relative
to the document

or the site root

Figure 5-15.

Setting the name and location for an external CSS fi le.
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 94. Click the Options menu in the upper-right corner of the Snippets panel, as 
shown in Figure 5-16. Click Close in the drop-down menu. The Snippets panel 
is closed (hidden).

 95. Click the workspace switcher button, and click New Workspace… in the drop-
down menu.

 96. In the New Workspace dialog box, enter My Custom Workspace in the Name: text 
box, and click the OK button. A custom workspace with this name is saved and 
set current. It will appear in the drop-down menu displayed by clicking the 
workspace switcher button.

 97. Click Edit>Preferences… on the Menu bar.

 98. On the left-hand side of the Preferences dialog box, click Sync Settings.

 99. On the right-hand side of the dialog box, click the Sync Settings Now button. 
This will synchronize the custom workspace to your Creative Cloud account. 
Close the Preferences dialog box.

 100. Applying what you have learned, change to the Developer workspace, and fl oat 
the Snippets panel.

 101. Click the workspace switcher button, and click Reset ‘Developer’ in the drop-
down menu. The Developer workspace is returned to its default settings and 
panel locations.

 102. Applying what you have learned, restore the Standard workspace.

Lesson Review

Vocabulary
In a word processing document or on a sheet of paper, list all of the key terms in 
this lesson. Place each term on a separate line. Then, write a defi nition for each 
term using your own words. You will continue to build this terminology dictionary 
throughout this certifi cation guide.

Options menu

Figure 5-16.

Using the panel Options menu.
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Review Questions
Answer the following questions. These questions are aligned to questions in the 
certifi cation exam. Answering these questions will help prepare you to take the exam.

 1. How can a designer test if content is relevant to the target audience?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 2. What are two things a designer should do to create a kid-safe website?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 3. What fi ve items should be included in a statement of work?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 4. What should be included in a wireframe panel in addition to the layout 
drawing?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 5. What are two items that the designer should list on the storyboard when using 
rich media?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 6. Which CSS structure is the most effective in separating the content from the 
design of the website?

 ___________________________________________________________________________________

 7. Hover the cursor over the buttons on the Insert panel to reveal the name for 
each tool. Under which tab is the command to insert a form? A table? Text tags 
such as <b> and <h2>? Media such as SWF and FLV?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 8. On what toolbar is the text box to change the title of the web page?

 ___________________________________________________________________________________

 9. Which view option allows the designer to see the design and code view at the 
same time?

 ___________________________________________________________________________________

 10. Which tool on the Properties panel is used to assign the Heading 3 style to 
selected text?

 ___________________________________________________________________________________

 11. Which HTML tag is used to apply bold formatting to text?

 ___________________________________________________________________________________
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 12. How would you identify in the code view text that has the Heading 1 style 
applied to it?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 13. Which command on the Properties panel is used to access tools to change the 
font color and background color as an internal CSS style sheet?

 ___________________________________________________________________________________

 14. How is a panel docked to another panel?

 ___________________________________________________________________________________

 ___________________________________________________________________________________

 15. How is a panel closed?

 ___________________________________________________________________________________
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Answers

Lesson 1
 1. Shape, form, line, color, value, space, and texture.

 2. Regular shapes and objects that are used to 
assemble more complex shapes or objects.

 3. The primary colors of red, blue, and yellow.

 4. A complementary color is located opposite of 
the selected color on the color wheel, while an 
analogous color is located next to the selected 
color.

 5. Positive space is the area or volume occupied by 
the primary objects, while negative space is the 
area or volume around or between the primary 
objects.

 6. The point or points in a perspective drawing 
where receding parallel lines appear to meet.

 7. Movement, emphasis, harmony, variety, balance, 
contrast, proportion, pattern, and unity.

 8. Movement.

 9. Emphasis.

 10. Balance.

 11. An image is divided into three sections 
horizontally and three sections vertically to 
create nine areas, and where the lines cross are 
the focal points for a scene.

 12. Contrast.

 13. Unity.

 14. proximity

 15. Shorter development time, easier maintenance, 
and improved usability.

Lesson 2
 1. PNG-24

 2. GIF, PNG-8, PNG-24, JPEG, BMP, and RAW or 
CIFF. (There are other fi le types.)

 3. CGM, AI, and EPS. (There are other fi le types.)

 4. RGB color model at a resolution of 72 or 96 dpi.

 5. The alpha channel allows for a masking 
color, which is a single shade of a color that 
determines areas of transparency in the image.

 6. Vector.

 7. The process of converting a raster image into a 
vector image.

 8. Raster images are composed of colored dots 
at specifi ed locations, while vector images 
are composed of elements recorded by their 
mathematical defi nitions.

 9. Applying the most appropriate resolution and 
fi le compression.

 10. Download it from a digital camera.

 11. The image is dithered, and the software creates 
a color through interpolation.

 12. 576

 13. Bicubic for enlargement.

 14. A serif font has decorations called serifs at the 
ends of letters, while a sans serif font lacks these 
decorations.

 15. In the Advanced Settings within Site Setup.

Lesson 3
 1. To reduce the amount of data on any one 

network cable.

 2. The URL is interpreted by a domain name 
server (DNS) into an Internet protocol (IP) 

address, which is used to direct the browser to 
the correct web page.

 3. A domain name is much easier to recognize and 
remember than an IP address.
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 4. A hyperlink is an electronic link between a 
marked place in a document to another place in 
the document or to another document, fi le, or 
web page, while a bookmark is a location saved 
to an organizational area in software.

 5. The <meta> tag.

 6. The .com top-level domain indicates a commerce 
site.

 7. Click the Back button or press the [Backspace] 
key.

 8. </script>

 9. In the HEAD section.

 10. <meta element data>

Lesson 4
 1. Eight seconds.

 2. It creates an uncluttered look, which helps focus 
attention.

 3. Age, income, race, education level, participation 
in a specifi c activity, or other characteristics.

 4. Sixteen.

 5. Old technology may be sold in emerging 
markets.

 6. Resolution and color.

 7. By including design elements that can be 
understood regardless of the user’s spoken 
language.

 8. Persons with hard-to-control movement of 
fi ngers, hands, and other parts of the body can 
input commands.

 9. It reads the alt text assigned to the image.

 10. CSS3 media queries, scalable image size, 
resizable fonts, and device-specifi c HTML.

Lesson 5
 1. Survey members of the target audience.

 2. Create age-appropriate content and provide a 
kid-safe registration.

 3. 1) What type of work the client is hiring you 
to do, 2) the scope of work that the designer is 
to perform, 3) all mandatory deliverables, 4) all 
mandatory deadlines, and 5) how many changes 
are included without additional charges.

 4. Important features of the web page, element 
layout, color palette, font samples, and 
navigation description.

 5. How to address technology lag and controls to 
be used.

 6. An external style sheet.

 7. On the Insert panel: Forms tab, Common tab, 
Text tab, and Common tab.

 8. The Document toolbar.

 9. The split view displayed by clicking the Split 
button.

 10. The Format drop-down arrow, which is available 
after clicking the HTML button in the Properties 
panel.

 11. <strong>

 12. The text is enclosed within the <h1> opening tag 
and the </h1> closing tag.

 13. The Page Properties… button, which opens the 
Page Properties dialog box containing these 
tools.

 14. Drag the panel until the cursor touches the tab 
for the panel to which it will be docked.

 15. Click the Options menu in the upper-right 
corner of the panel, and click Close in the drop-
down menu.

Lesson 6
 1. HTML4 and XHTML

 2. It allows a page to load faster and also requires 
less coding.

 3. The <canvas> tag allows for a drawing area to 
be created within a web page. The <audio> tag 
controls the sound on a web page.
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 4. Designers create and store code for reuse as 
snippets so the code can be easily copied and 
pasted where needed.

 5. Include multiple video formats, use multiple 
video sources, and make the video searchable.

 6. Limit the number of moving images and avoid 
using animations that last more than a few 
seconds.

 7. The original image and the rollover image.

 8. Up (normal; not pressed), down (pressed), over 
(rollover and not pressed), and over while down 
(rollover and pressed).

 9. A hotspot is a clickable section of the image, and 
the target is the link that will be opened when 
the hotspot is clicked.

 10. Client-side elements are controlled within the 
browser, and server-side elements are controlled 
by a program running on the server.

 11. There is no restriction because the copyright 
holder is giving permission for use.

 12. To open, download (get), upload (put), update, 
and develop the site structure by organizing 
fi les and folders.

 13. Click the right-hand drop-down arrow in 
the Files panel, and select Remote server in 
the drop-down list. A remote server must be 
defi ned. Then click the Connect to Remote 

Server button.

 14. Use the Alt text box on the Properties panel.

 15. Enter the alternative text in the Alt text box.

 16. Click the Brightness and Contrast button in the 
Edit area of the Properties panel, and enter 30% 
in the Brightness text box in the Brightness/

Contrast dialog box.

 17. Add them to the Favorites list in the Assets 
panel.

 18. By assigning a mailto: link to an image or text or 
using the Email Link button on the Common tab 
of the Insert panel.

 19. Right-click on the asset, and click Align>Right in 
the shortcut menu, or adjust the property for the 
asset in the Properties panel.

 20. <a href=“http://www.linkedin.com”>LinkedIn</a>

 21. The Files panel, Assets panel, and Insert panel.

 22. The Circular Hotspot Tool button.

 23. The Pointer Hotspot Tool button.

 24. The Polygon Hotspot Tool button.

 25. The Rectangle Hotspot Tool button.

 26. The <base> tag.

 27. A template.

 28. Click and hold the Point to File button in the 
Properties panel, drag it to the Files panel, and 
release the mouse button when the leader points 
to the hobbies.htm fi le.

 29. To verify the link in a web browser.

 30. It provides a list of external links, but it does not 
verify that external links are correct.

Lesson 7
 1. Load time, effi ciency of use, and ease of 

navigation.

 2. Place it in a menu that appears on every page of 
the website.

 3. If the users’ adaptation to the navigation of 
the site and the users’ level of acceptance and 
satisfaction.

 4. (any three) Web forms, site reports, e-mail links, 
and on-demand chat.

 5. Information should be easy to verify, contact 
should be easy, and information should be 
updated when needed.

 6. Editing the background color in the CSS, 
replacing a few images, and adding a little text.

 7. To allow only one designer to make changes at a 
time.

 8. It displays the lines of code for the web page and 
the CSS rules. It also allows the related fi les to be 
opened.

 9. Click Div on the Insert panel, or add the opening 
<div> and closing </div> tags in the code view.

 10. header

 11. Ordered list, unordered list, and list item or 
element.

 12. It displays each DIV container with a different-
colored background to help identify each 
container.
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 13. Entered as code or inserted using Dreamweaver 
commands.

 14. The <font> tag is not supported in HTML5.

 15. The Add to Personal Dictionary option.

Lesson 8
 1. Text fi elds, hidden fi elds, buttons, check boxes, 

radio buttons, list menus, and fi le fi elds.

 2. Click the drop-down arrow at the top of the 
panel, and click Form in the drop-down menu.

 3. It sets the order in which elements on the form 
will be navigated when the [Tab] key is pressed.

 4. The tab index should create a logical order from 
the top of the form to the bottom of the form.

 5. It can show the user the format in which to enter 
data, or it can provide a common value the user 
can accept instead of having to enter data.

 6. A select, or list, menu can help prevent input 
errors by limiting user input to only the values 
in a drop-down menu.

 7. All other radio buttons are off as only one radio 
button in the group can be on at a time.

 8. It clears all data from the form and returns it to 
its default state.

 9. The Form Action text box is used to specify what 
action will be taken with the button is clicked.

 10. If the tab index does not create a logical order 
for navigating the form, the user may become 
confused and skip or miss entering some data or 
submit a form with incorrect data.
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